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Company and Customer CONFIDENTIAL

1. LOGGING INTO FIELD STATION MANAGER

When you run any of the HARVESTER COMINT Suite applications, you will first be 
presented with the standard login  screen.  The screen will  display  the name and 
version of the application being run. It may also display user security warnings and 
caveats. These notifications are maintained by your system administrator.

The screen will ask you to enter your username and password and once entered, you 
should click the Login button to proceed with the login process.

If  both username and password are correct,  the application will  open as normal.  
However if either or both credentials cannot be authenticated, the following warning 
message will be displayed:

Ensure that both your username and password have been entered correctly and try 
logging in again. If you are still denied access, contact your system administrator.

If your credentials are correct and authenticated by the system but you do not have 
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user permissions to run the application, then the login process will be halted and you 
will be presented with the following warning:

Applications  may  also  be  disabled  by  system  administrators  for  maintenance  or 
other operational  reasons.  If  the application you are trying to log into has been 
disabled, you will see the following warning:

If the HARVESTER COMINT Suite database has recently been upgraded by a System 
Update  and  you  have  not  yet  deployed  updated  applications,  logging  into  an 
application may result in the following warning being displayed:
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Not  all  System  Updates  will  require  new  versions  of  HARVESTER  COMINT  Suite 
applications to be deployed. Please refer to any System Update release notes to 
coordinate application deployment and avoid any impact on user access.

If the application is started and no PKI security file is present, then following warning 
message  will  be  displayed.  Contact  your  system  administrator  and  request  the 
harvester.pki file to be added to your local installation.
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2. FIELD STATION MANAGER

Field Station Manager is a tool of managing and maintaining the inner workings of 
HARVESTER COMINT Suite. The application main window consists of ten individual 
sections  covering  all  the  operational  areas  of  HARVESTER  COMINT  Suite.  These 
include  an  inventory  of  equipment  (antennas,  receivers  and  other  intercept 
equipment), user access and security, application security, maintenance of emissions 
and modulation systems,  intercept locations and positions,  frequency ranges and 
tools of the importing and exporting of system data, as well as the registering of 
workstations and loading of licence keys.

The main window is shown below and is split into a left hand navigation menu and a 
right hand information panel.

2.1 Setting up Field Station Manager
Once HARVESTER COMINT Suite has been installed, the database has been setup and 
the initial system data load has been completed, the next step is to set up a point of  
contact within Field Station Manager. This is essential for registering workstations 
but also provides a contact for notifying software and data updates.

From the File menu, click the Contact Details option to open the Contact Details 
window:
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NOTE: The mandatory fields on this window are Contact Name, Email Address 
and Country. These fields are required to create a fully functioning workstation 
registration file. We have dramatically reduced the requirements on customer 
data to an absolute minimum and only require this very limited set data to 
ensure good communications with our customers (we will only communicate 
with  the  contact  name  and  email  address  specified  here)  and  correctly 
generate your SIGAD. We are committed to the privacy and security of our 
customers and treat all customer data with extreme care. We never have, and 
never will share or sell customer data to advertisers, third parties or any private 
or commercial entity or organs of state.

2.2 Changing User Password
You can change your password at any time but selecting the Set New Password 
option from the Tools menu. 

Confirm your current password then enter and confirm your new password and click 
OK to set your new password.
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NOTE: Passwords must be a minimum length of 8 characters. Password history 
is enforced by default on user accounts therefore you will not be able to reuse 
a password.

2.3 Applications
Applications provides a list of all  current applications that have connected to the 
HARVESTER  COMINT  Suite  database.  Entries  are  automatically  added  as  each 
application connects. Double-click on the application name in the right panel to open 
the application properties window:

The  application  name  field  is  defined  by  individual  applications  logging  into  the 
system  and  cannot  be  amended.  The  Application  Enabled  check  box  allows 
administrators to disable all user access to a particular application. Users attempting 
to login while an application is disabled will be presented with the following warning:
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NOTE: Disabling an application only applies to future logins. Users already 
logged into the application can continue to work as normal but once they 
logout, they will not be able to login again unless the user account has 
administrator priviledges.

2.3.1 Security
The Security tab provides administrators with the option to enabling the application 
security feature and adding on-screen operator security warnings to applications as 
well as defining application specific security warning messages that appears on the 
application’s login screen.

2.3.1.1 Application Security (Professional Version Only)
Application Security provides the ability for administrators to define the minimum 
and maximum classification that any application is allowed to process. This feature 
integrates  directly  with  operator  security  profiles  to  control  access  to  both 
applications and the data held within each application. Application Security follows 
the model providing four security related settings:

 Minimum Classification. This is the minimum classification that any piece of 
information  or  data  will  have  within  the  application.  Generally,  this  is 
considered to be Unclassified.

 Maximum Classification. This is the maximum classification that any piece of 
information or data will hold within the application.

 Compartment. In collection environments where access to information from 
different  collection  systems  and  projects  is  required  to  be  formally 
controlled,  compartmentalization  can  be  used  to  assign  a  specific 
compartment to an appication.

 Dissemination. Dissemination allows the distribution of data and information 
to be defined at the application level.

Application  Security  is  displayed  as  a  security  banner  appearing  at  the  top  and 
bottom of the screen. By default, this option is disabled. 
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2.3.1.2 User Security Warning
In the User Security Warning box, you can defined the security message that appears 
in the application’s login screen. 

2.4 Collection Systems
Collection Systems provides a list of all collection systems currently attached to the 
system. The default collection system is HARVESTER which is a generic system that 
allows collection over the broadest spectrum.

2.5 Emissions
Emissions provides a list of all currently available Emission systems in the database.  
This  list  is  composed  of  the  default  list  of  emissions  provided  with  HARVESTER 
COMINT Suite and any new emissions that may have been created by users to meet 
local intercept requirements.

NOTE: New emission systems can only be added by registered workstations.
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To create a new emission, right-click Emissions in the left hand menu and select Add 
New from the menu or right-click any emission in the right-hand panel and select 
New from the menu. This will open the Add Emission window.

Enter  the  name of  the  new system and any  known aliases.   Check  the  Enabled 
checkbox to ensure that the emission appears in the emission dropdown list on the 
Add Emitter window. Select the modulation system used by the system – this is used 
by the system to set the receiver mode when automatic receiver tuning is enabled. If  
the new emission is a multiplexed system, enter the number of channels supported 
by the emission.

NOTE: The  Emission  Name  of  default  emission  systems  supplied  with 
HARVESTER COMINT Suite cannot be changed.

The Parameters tab provides a selectable list of reporting parameters that can be 
gathered by the parametric reports module in the Collection Operator Terminal. 
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The selected parametrics are displayed in Collection Operator Terminal frequency 
lists  as  depending  on  the  Parameter  Format.  The  available  parametrics  format 
options are:

 Baud Rate/Shift
 Bit Rate/Interleave
 RPM/IOC
 Words Per Minute
 Bit Rate/Interleave

2.6 Inventory
Inventory provides a list of all currently available intercept equipment that is used 
users  to  meet  local  intercept  requirements.  This  list  is  composed  of  antennas,  
receivers and any additional collection, intercept, recording and analysis equipment 
used  by  the  station.   The  system Inventory  provides  a  useful  repository  for  the 
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management, allocation, repairs and maintenance scheduling of all local intercept 
equipment. 

2.6.1 Antennas
To create a new antenna, right-click Antennas in the left hand menu and select Add 
New from the menu or right-click any antenna in the right-hand panel and select 
New from the menu. This will open the Add Antenna window.

NOTE: If an antenna is intended to be used in direction finding operations, it is 
essential that the latitude and longitude of the antenna are entered to enable 
location analysis to be carried out
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2.6.1.1 Service History
The Service History tab provides a useful tool for recording any repairs, servicing and 
modifications carried out on the antennna.

To add a new record, click the Add button to open the Add Service Item window:

SIGINT Systems  2025 Page 12 of 32



Company and Customer CONFIDENTIAL

2.6.2 Equipment
To create a new piece of equipment, right-click Equipment s in the left hand menu 
and select Add New from the menu or right-click any equipment in the right-hand 
panel and select New from the menu. This will open the Add Equipment window.
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2.6.3 Receivers
To create a new receiver, right-click Receivers in the left hand menu and select Add 
New from the menu or right-click any receiver in the right-hand panel and select 
New from the menu. This will open the Add Receiver window.
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The Receiver Control tab provides options to configure parameters for automatic 
receiver  tuning control  from within the Collection Operator  Terminal  application. 
Select the matching receiver from the Command Protocol dropdown list then enter 
the  hexadecimal  receiver  address  if  required.  Command  Protocols  are  currently 
available for three different receiver manufacturers:

 Icom
 Japan Radio
 Winradio

NOTE If your particular receiver is not included, please contact us.

Standard serial port configuration for the selected receiver can also be entered on 
this page, with the physical serial being set within the Collection Operator Terminal  

SIGINT Systems  2025 Page 15 of 32



Company and Customer CONFIDENTIAL

application. If you are unsure of the serial port configuration for any receiver, click  
the Use Defaults button to load the standardised settings for the selected receiver.

2.7 Languages
Languages provides a list of all currently available languages in the database. This list 
is composed of the default list of languages provided with HARVESTER COMINT Suite 
and any new languages that may have been created by users to meet local intercept 
requirements.

NOTE: New languages can only be added by registered workstations.

To create a new languages, right-click Languages in the left hand menu and select 
Add New from the menu or right-click any emission in the right-hand panel  and 
select New from the menu. This will open the Add Language window.
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NOTE: The Language Name of default languages supplied with HARVESTER 
COMINT Suite cannot be changed.

2.8 Locations
Locations provides a repository for any fixed and temporary intercept locations used 
for local collection and intercept requirements. These locations can then be selected 
within the Workstation window to be set against intercept positions.

To create a new location, right-click Locations in the left hand menu and select Add 
New from the menu or right-click any location in the right-hand panel and select 
New from the menu. This will open the Add Location window.
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2.9 Modulations
Modulations provides a list of all currently available Modulations in the database. 
This list is composed of the default list of modulations provided with HARVESTER 
COMINT Suite and any new modulations that may have been created by users to 
meet local intercept requirements.

NOTE: New modulation systems can only be added by registered workstations.

To create a new modulation, right-click Modulations in the left hand menu and select 
Add New from the menu or right-click any modulation in the right-hand panel and 
select New from the menu. This will open the Add Modulation window.
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NOTE: The Modulation Name of default modulations supplied with HARVESTER 
COMINT Suite cannot be changed.

2.10 Security (Professional Version Only)
The Security module provides the tools for the management of system and data 
access in a professional collection environment through the use of clearances and 
data compartments.

2.11 User Accounts
User Accounts provides functionality to create, management and disable individual 
users within the HARVESTER COMINT Suite system. 

NOTE: HARVESTER COMINT Suite is installed with the default administrator 
user account ALPHA. This account can be used to configure and manage the 
system as well as creating new users.
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To create a new user, right-click User Accounts in the left hand menu and select Add 
New from the menu or right-click any user in the right-hand panel and select New 
from the menu. This will open the Create New User Account window.

User  accounts  can  be  created  by  selecting  one  of  two  generation  methods: 
username or system generated username. 

 Username. This method is best suited for specific named accounts, such as 
admin, administrator or any other production-type account. The username 
can be a maximum of 64 characters in length.

 System Generated Username. This method is best suited for individual user 
accounts and uses a combination of the user’s forenames and surnames to 
automatically generate a unique username. Usernames are usually no longer 
than 7 characters.
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2.11.1 Passwords
Passwords are case-sensitive and can be up to a maximum of 40 characters in length 
and must  be a  minimum of  8  characters.  All  special  characters  are  permitted in 
passwords.

2.11.2 Account Options
All users accounts have a number of options that can be applied to them:

 Administrator. Enabling this option provides the account with full access to 
the system however administrator accounts still require implicit privileges to 
access specific applications.

 Force password change at next logon. This option forced a user to change 
their password when they next log into the system.

 User cannot change password. This option disabled the Set New Password 
option is any application that the user logs into. This setting is not 
recommended for normal user accounts but may be useful for shared 
production accounts.

 Enforce Password History. This option prevents users to recycling passwords 
by keeping an encrypted history of the passwords they have used in the past.

 Account is disabled. This option completely disabled the user account. 

NOTE: In order to maintain an accurate historical record of system usage, User 
Accounts cannot be deleted. User accounts that are no longer required or no 
longer in use should be set to disabled.

Once all information and options have been entered, click the OK button to create 
the user account. If successful, the new user account will appear in the list of user 
accounts in the right-hand panel. 

Once created, a user account can then be edited to add additional privileges such as 
implicit access to different applications within HARVESTER COMINT Suite. Double-
click the user account in the right-hand panel to open the Edit User Account window.
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2.11.3 User Security Clearances (Professional Version Only)
Within  a  professional  collection  environment,  there  is  often  a  need  for  stricter 
management of system access, defining access at a far more granular level.  in terms 
of clearances and data compartments.

2.11.4 Application Access
Application  Access  provides  a  tool  for  managing  user  access  to  individual 
applications  within  HARVESTER  COMINT  Suite.  By  default,  all  user  accounts  are 
created with no access to any of the applications.  Administrators must therefore 
explicitly grant access to applications before a user can log in and use them. Click the 
applications that the selected user requires to use and click the OK button.
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2.12 Workstations
The  Workstations  module  provides  an  automatically  updated  list  of  all  the 
workstations  that  have  logged  into  HARVESTER  COMINT  Suite  using  one  of  its 
applications. Double-click on any workstation to open the Edit Workstation window.

The Edit Workstation window provides a number of configuration options for the 
workstation. Workstation Name is automatically set as the machine hostname as 
defined within Windows and cannot be changed. 
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Position Type defines what type of work that the workstation is engaged in. There 
are currently five workstreams:

 Morse
 Non-Morse
 Search and Development
 Voice
 Workstation

Position Designator, which defaults to the Windows hostname of the machine, can 
be used to annotate a target or coverage type and appears on intercept logs and 
reports. In the example above, the designator SKD-GRP-AT4 refers to a collection 
tasking.

Ensure that the Position Enabled checkbox is ticked to ensure that the workstation 
can log into the HARVESTER COMINT Suite.
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The Setup tab allows for more specific configuration of the workstation in terms of 
the intercept and collection equipments it has been allocated as well as frequency 
scope and the allocation of a TEXTA block assignment.

2.12.1 Installed Equipment and Available Antennas
If  you intend to enable automatic receiver tuning,  it  is  essential  that the correct 
receivers are defined in the Installed Equipment list. Click the Add button to open 
the list of available receivers, as defined in Section 2.6.3 Receivers above. Select the 
receivers accessible to the workstation and click OK. The receivers added here will 
appear in the receiver dropdown list in the Collection Operator Terminal and when 
connected to the application, can be controlled automatically by the software.

The Available Antennas list provides a listing of all installed antennas. These may be 
used exclusively by the workstation or shared with other positions and receivers.

2.12.2 Terminal Intercept Scope
By default, all workstations are assigned to the HARVESTER collection system with an 
initial  frequency  intercept  scope ranging  from 0  to  1  GHz.  Should  a  workstation 
require to operate within a more limited frequency range such as HF only, then the 
minimum and maximum frequency operating limits can be defined here.

Like the Position Designator on the General tab, Position Description can be used to 
store targets and/or tasking that the position has been allocated. This is particularly 
useful  in collection environments where individual  positions are assigned specific 
targets to collect.

2.12.3 TEXTA System
The TEXTA Block Assignment is  used in  the generation of  temporary TEXTA case 
notations. It allows a station to assign temporary case notation bases on a specific 
tasking or project that is a sub-group of the overall intercept and collection effort. 
Management of block assignments is a T/A function and are maintained within the 
TEXTA System application.

2.12.4 Configuration
This tab provides a free-text box where notes can be stored about specfic installation 
and  setup  requirements  or  settings  for  the  workstation.  It  also  provides  two 
application settings:

 Frequency Search Ranges.  These check boxes enable and disable the search 
ranges within the Collection Operator Terminal and define the width of 
frequency search windows within the application. The options are band 
specific so for example, a 5 and 10 kHz would suit HF collection but not UHF.

 Operator Support Pages. This section enabled and disabled access to 
additional information modules within the Collection Operator Terminal.
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2.13 Registration
Registration of  a  workstation is  an  essential  step  to  gain  the  full  benefit  of  the 
applications that form the HARVESTER COMINT Suite. Registration is managed on a 
per-seat basis so that registering a workstation opens up the full functionality of all  
applications  that  are  installed.  To  register  a  workstation,  select  the  Generate 
Registration File option for the Tools, Registration and Licencing menu. This will open 
the Generate Registration File window. 

SIGINT Systems  2025 Page 26 of 32



Company and Customer CONFIDENTIAL

Select the workstations that you wish to register and click the Build button. The file 
generation process will begin and the progress will be reported in the progress bar.  
Once completed,  the location of the registration file will be displayed on screen. This 
file then needs to be sent to SIGINT Systems for a licence file to be created.

One  key  part  of  the  registration  process  is  that  your  contact  details  have  been 
entered into the Detail  Details window. If you have not done this, select Contact 
Details from the File menu and entered your details before continuing. If this is not 
done, the file generation process will be halted and the following message will be 
displayed on screen:

2.13.1 Loading Licencing File
To load a licencing file, select the Load Licence File option for the Tools, Registration 
and  Licencing  menu.  This  opens  the  Load  Licence  File  window.  Navigate  to  the 
licencing file for your installation supplied to you by SIGINT Systems. Filenames are 
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normally  of  the  form  yyyymmddhhmmss.lic.   Select  the  file  then  click  the  Open 
button. 

Once the licence file has been successfully validated and loaded, the following 
message will be displayed on screen:

If the file you try to load is not a genuine licence file, the licencing process will be 
halted and the following message will be displayed:

Similarly, if there are any issues loading the licence file, the licencing process will be 
halted and the following message will be displayed:

If there are any issues loading the licence file, please contact SIGINT Systems.

2.14 System Updates
From time to time, SIGINT Systems will  issue System Updates. These can contain 
data updates as well as architectural database updates to enable new functionality 
added to applications. System Updates will always be released wih accompanying 
release notes so that users are made fully aware of the updates included. As with all  
enterprise level applications, we strongly advise users to always take a full database 
update before applying any system update.

SIGINT Systems  2025 Page 28 of 32



Company and Customer CONFIDENTIAL

To load a System Update file,  select the Load System Update File option for the 
Tools, System Updates menu. Navigate to and select the System Update file then 
click the Open button

NOTE: System Updates can only be loaded by licenced instances of Field 
Station Manager.

If the file selected is not a valid System Update file, the following message will be  
displayed.

If the selected file is a valid System Update file, the System Update Utility will open 
and display the version and name of the System Update as well as a description. It  
will also display a list of the individual update steps included in the update.
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NOTE: Before starting the update process, it is critical that you refer to the 
System Update release notes to confirm the expected number of steps in the 
update. If the number of steps on screen do not make the expected number of 
steps in the release notes, do not continue with the System Update.

Click the Start button to begin the update process. Update steps will be processed 
sequentially and the corresponding status will be updated at the end of each step.  
The update should end with all steps being updated to ‘Completed’ however in the 
event that an error is encountered, the status will be updated to ‘Error’. Individual 
error steps can be examined by double-clicking the step. This will open a message 
box showing the error associated with the failed step.

A successfully applied update will end with the ‘Successfully Applied’ message:

2.15 Data Systems
The Data Systems module provides data support functionality for a number of query 
focussed datasets that run in the background of HARVESTER COMINT Suite which 
present analysts with searchable coverage, intercept and message digests.  It  also 
provides data export and import tools for handling a variety of pre-defined datasets. 
This module is not available in demo mode.

2.15.1 Datasets
HARVESTER  COMINT  Suite  currently  makes  use  of  two  query  focussed  datasets 
(PENDRAGON and TANGERINE)  to  supply  data to  the Traffic Analysis  Workbench 
modules of Order of Battle and Log Analysis. These datasets require to be regularly 
refreshed  so  that  the  latest  information  is  available  for  analysis.  The  interval  
between refreshes can be vary according to requirements. As a guide, the freshness, 
or age, of the data, formatted in hours, minutes and seconds, is displayed alongside 
each dataset.
 
To refresh a dataset, select the Datasets tab in the Data Systems module. Select the 
dataset that you wish to refresh and either right-click the dataset and select the 
Refresh Dataset option from the menu or click the Refresh Dataset button on the 
toolbar. The dataset refresh process will begin immediately and the results will be 
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written to the refresh log with a “Refresh successfully completed” message. If there 
are any issues during the refresh process, the errors will appear in the Error Message 
column of the refresh log.

2.15.2 Data Exports and Imports
HARVESTER COMINT Suite currently supports two shared query focussed datasets 
(GLOBAL HARVEST and TEXTA Database) which can be used to exchange data. To 
export a dataset, select the Data System Extracts tab in the Data Systems module 
then select the Data Exports tab.
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Select  the dataset that you wish to export  and either right-click the dataset and 
select the Export option from the menu or click the Export button on the toolbar to 
open the Data Export window.

Select  the day range you wish to export  and click the Build button to begin the 
export. The dataset export process will  begin immediately and the results will  be 
written to the export log with an “Export OK” status message. If there are any issues 
during the export process, the errors will appear in the Error Message column of the 
export log.

Export files are written to the Output folder inside the Harvester installation folder 
and a message will be displayed onscreen at the end of the export confirming both 
the file location and the filename of the export.
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